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ABSTRACT: Robotic arm has become popular in the world of robotics. The essential part of the robotic arm is a 

programmable microcontroller-based brick capable of driving basically 3 stepper motors design to form an 

anthropomorphic structure. In this anticipate an automated arm with four degrees of opportunity is composed and can 

pick the items with a particular weight and place them in a sought area. To encourage the lifting of the items, motors 

are utilized. This abstract explains the method of interfacing the robotic arm  motors with the programmed A based 

microcontroller which are used to control the robot operations. A sample robot which can grab and release small 

objects is built for demonstrating the method explained. In this project, the main application is control of multiple 

operations and movement of conveyer using time-based Microcontroller. The initial phase of the project focuses on 

passing the inputs to the microcontroller so as to identify the number of different workstations available in the industry 

which are specified by the user. Automated pick and place a framework comprises of a preparing station, testing 

station, and sorting station. 

 
I.  INTRODUCTION 

 
The field of robotics has its origins in science fictions. The word robot comes from the Czech word "robot" means 

forced labor in 1920. It took another 40 years before the modern technology of industrial robotics began. Today, robots 

are highly automated mechanical manipulators controlled by computers. A robot may appear like a human being or an 

animal or a simple electro-mechanical device. A robot may act under the direct control of a human (e. g. the robotic 

arm of the space shuttle) or autonomously under the control of a programmed computer. Robots may be used to 

perform tasks that are too dangerous or difficult for humans to implement directly (e. g. nuclear waste cleanup) or may 

be used to automate repetitive tasks that can be performed more cheaply by a robot than by the employment of a human 

(e. g. automobile production) or may be used to automate mindless repetitive tasks that should be performed with more 

precision by a robot than by a human (material handling, material transfer applications, machine loading and unloading, 

processing operations, assembly and inspection).  

 

 The last two decades have witnessed a significant advance in the field of robots application. Many more applications 

are expected to appear in space exploration, battlefield and in various actives of daily life in the coming years. A robot 

is a mechanical device that performs automated tasks and movements, according to either pre-defined program or a set 

of general guidelines and direct human supervision. These tasks either replace or enhance human work, such as in 

manufacturing, contraction or manipulation of heavy or hazardous material. Robot is an integral part in automating the 

flexible manufacturing system that one greatly in demand these days. Robots are now more than a machine, as robots 

have become the solution of the future as cost labour wages and customers demand. Even though the cost of acquiring 

robotic system is quite expensive but as today's rapid development and a very high demand in quality with IS0 

standards, human are no longer capable of such demands. Research and development of future robots is moving at a 

very rapid pace due to the constantly improving and upgrading of the quality standards of products. Robotic 

manipulators resembling the human arm is known as robotic arms. They are constructed by a structure consisting of 

structurally robust links coupled by either rotational joints or translating joints. A robotic arm is thus a type of 

mechanically coupled or joined arm, run by programmable commands, with similar functions to a human arm. It may 

be the sum total of the mechanism links or may be part of a more complex sized robot. A typical robotic arm has the 

following components: • Links and joints • Actuators • Controller • End-effector A link is considered as a rigid body 
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that defines the relationship between two corresponding joint axes of a manipulator. Manipulators consist of rigid links, 

which are connected by joints that allow relative motion of corresponding links. The links move to position with the 

end-effector. Actuators perform the same role the muscles perform in the human arm – they convert stored energy into 

movement energy. Actuators are used force to move a robot’s manipulator joints. The three common types of actuators 

currently using in contemporary robots are pneumatic, hydraulic, and electrical actuators. The robots play important 

roles in our lives and are able to perform the tasks which cannot be done by humans in terms of speed, accuracy and 

difficulty. Robots can be employed to imitate human behaviours and then apply these behaviours to the skills that leads 

the robot to achieve a certain task . They do not get tired or face the commands emotionally, and since they are 

designed by humans. They can be programmed and expected to obey and perform some specific tasks. In some cases 

the use of a robotic hand becomes remarkable. Robotic is applied in different forms and fields to simulate human 

behaviour and motions. The first usage of the word ‘robot’ was in a 1921 Czech science fiction play – ‘Rossum’s 

Universal Robots’ – by Karel Capek. The robots were artificial people or androids and the word was derived from the 

word ‘Robata’, a Czech word for slave. A question of perpetual interest is to define a robot. Since the beginning of the 

study of robotics, there has been some controversy in the definition of a robot. So long as the evolution of robotics 

continues, the definition of the robot will change from time to time, depending on the technological advances in its 

sensory capability and level of intelligence. However, the most widely accepted definition of a robot was given by the 

Robotic Institute of America (RIA) in 1979. Robotic manipulators resembling the human arm is known as robotic arms. 

They are constructed by a structure consisting of structurally robust links coupled by either rotational joints or 

translating joints. A robotic arm is thus a type of mechanically coupled or joined arm, run by programmable commands, 

with similar functions to a human arm. It may be the sum total of the mechanism links or may be part of a more 

complex sized robot. 

 

Our project is specifically designed for the industrial sector, aiming to enhance production rates by implementing 

robotic pick-and-place automation. Pick and place robots have become a common sight in modern manufacturing 

environments, as they excel in performing simple and repetitive tasks. These robots offer several advantages to 

manufacturers, as they can work with high precision and at a lower cost compared to human labor. While humans 

possess greater flexibility in switching tasks, robots are specialized for specific work assignments. However, the field 

of robotics is still in its early stages, and as robots evolve, they will become more versatile and capable of handling a 

variety of tasks. Building an effective individual robot is challenging, requiring a combination of intelligence, mobility, 

adaptability, navigation, and purpose. Currently, robots have gained significant importance in society, but there is still 

more progress to be made before individual robots become as impactful as personal computers. 

 

In today’s Industry and shop floors, industrial automation is everywhere and it is difficult to imagine a production line 

without automation. Industrial automation uses control systems and equipment, such as computer software and robots, 

to perform tasks. These systems operate industrial equipment automatically, significantly reducing the level of operator 

involvement and oversight required. One machine/mechanism that is most visible in industrial automation is the 

Mechanical pick and Place mechanism. Pick and place automation speeds up the process of picking up parts or items 

and placing them in other locations. Automating this process helps to increase production rates. Pick and place robots 

handle repetitive tasks while freeing up human workers to focus on more complex work. With a variety of design 

options available, pick and place machines can be configured with various end-of-arm tooling options for use in 

different applications, such as assembly, packaging, or bin picking. The Mechanical Pick & Place Machine, our project, 

aims to show the simple working of the mechanism. Pick and the place is the act of picking things up from one location 

and placing them in another. Specific cases include:  Picking and placing is one of the major uses of industrial robots  

In the context of electronics, SMT placement equipment  In the context of logistics, an automated storage, and 

retrieval system 

 

II. LITERATURE SURVEY 
 

[1] Arka Sain, Janardan Dattani, and Dhara M Mehta, “Design and Implementation of Wireless Control of Pick and 

Place Robot Arm”, International Journal of Advanced Research in Engineering and Technology (IJARET), p-ISSN: 

0976-6480 and e-ISSN: 0976-6499, Volume 9, Issue 3, May – June 2018. It has designed and fabrication of pneumatic 

arm for pick and place of cylindrical objects. The handling of materials and mechanisms to pick and place of objects 

from a lower place to a higher place and widely found in factories and industrial manufacturing. There are number of 

pneumatic arms are available which consists of so many mechanisms hence become expensive. The designed 

pneumatic arm consists of two cylinders, a shaft works with lead screw mechanism capable of converting motion of 

piston to rotational motion of arm with help of using compressed air. The designed process are carried out based on 
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integrated information of kinematics dynamics and structural analysis of the desired robot configuration as whole. [2] 

M.J. Sawarkar, Trupti R. Raut, Nutan P. Nemad, Sonal C. Meshram, Pournima P. Tabhane, “Pick and Place Robotic 

Arm Using Android Device”, International Research Journal of Engineering and Technology (IRJET), e-ISSN: 2395-

0056 and p-ISSN: 2395-0072, Volume: 04, Issue: 03, Mar-2017. IT has design the system for pick and place of 

machine components of CNC-Lathe. Automation is termed as the use of different control systems such as numerical 

control, programmable logic control or another industrial control system in concern with computer applications or 

information technology to manipulate all the industrial machinery and processes, thus reducing the need for human 

intervention. Automation plays a dominant role in the world economy these days and in daily application in industries. 

[3] M.T. Islam, M.A. Wazed and T.Mohammad, “Design and Fabrication of a 5 DOF Dexterous Robotic Arm for 

Industrial Tasks”, International Conference on Mechanical Engineering 2007, ICME07-AM-58, 29-31 December 

2007.Have main objective of their project are to design and implement a four DOF pick and place automation. To 

determine the end effectors position and orientation, theoretical analysis of inverse kinematics is carried out. Ansys 

software is used for FE Analysis. This project aims to design and fabricate the pneumatic arm for pick and place of 

cylindrical objects. They conclude that arm is controlled by manually flaw control and direction control valve. Arm 

rotation and movement is done by pneumatic cylinder using helical slot mechanism. Total arm weight is 25 kg. The 

model is expected to lift at least 10 kg weight, Experimental aim is to collaborate the gripper mechanism and vacuum 

sucker mechanism working in single pick and place automation. [4] L. Xu, W. Zhou, X. Li, Wet gas flow modeling for 

a vertically mounted Venturi meter, Meas. Sci. Technol. 23 (4) (2012), 0453. Their purpose of work is to manufacture a 

light weight automation with a low-cost budget. They conclude that to avoid negative influence on the total weight of 

the arm, the plastic material reinforced with fiber is used and vacuum infusion man process is used for manufacturing. 

Local reinforced elements must be included during construction of arm shell. The mast light gear reducer, harmonic 

drive types are used but because of lack of alignment causes disassembly of gear package to avoid these flexible 

couplings are required. Gabrielle J.M. Tuithaf, Just L. Harder. Current automations are not safe for interaction with 

humans, especially for children therefore safe four DOF automation is develop. [5] Anil S. Maheshwari, Arpana 

Gangurde, Sachin Kadam, Gaurav Gangurde, Shubham Rathod, Department of Mechanical Engineering Design of 

Pneumatic Pick and Place Automation for Groove Grinding Machine, International Journal of Advance Research in 

Science and Engineering, 07 (2018) 655. The method for reducing the total energy consumption of pick and placed 

automations. It is seen that blowing down an operation as much as possible is not always beneficial. Energy 

consumption of given operation as a function of the task execution time. Future work includes improvement of the 

motor model, development of online programming algorithms. Analysis of speed, distance, load lifted by arm is done to 

know its performance. This automation expected to overcome the problem such as placing or picking object that is 

away from the user, pick and place hazardous object fast and easily. [6] S.N. Teli, Akshay Bhalerao, Sagar Ingole, 

Mahesh Jagadale, Kiran Kharat, Design and Fabrication of Pneumatic Robotic Arm, International Journal of Scientific 

& Engineering Research, 03 (2017)126. In his book various aspects of designing an automation is described. It deals 

with different types of Arm design, controlling techniques, vehicle design etc. ER. Rajput, in this book the operation 

and control of automation is discussed. Arduino cookbook, in this book details and methods of interfacing hardware 

components such as Stepper motor and UNO Arduino, is been discussed. [7] B. Mirtich, Y. Zhuang, K. Goldberg, J. 

Craig, R. Zanutta, B. Carlisle, and J. Canny, “Estimating pose statistics for robotic part feeders,” in Proceedings of 

IEEE international conference on robotics and automation, vol. 2. IEEE, 1996, pp. 1140–1146. They get inspired by the 

Octopus to and make an interesting model in automation due to its high dexterity, variable stiffness and very complex 

behavior. In this experiment they study the key features and patterns of movement of Octopus arm and this features and 

patterns and patterns of movement are that is elongation, shortening, bending and reaching etc. used for guide the 

movement of actuator. They conclude that the concept proposed for the mechanism at the base of the automation 

inspired to the Octopus muscular hydrostat where successfully implemented on mock-ups and the corresponding 

models have been modified and validate. [8] Masri Ayob and Graham Kendall. (2005) “A Survey of Surface Mount 

Device Placement Machine Optimization: Machine Classification”, Computer Science Technical Report, School of 

Computer Science and Information Technology, University of Notting. For the application of packaging pick and place 

robot using Arduino mega. This is helpful for the Palletizing application. International Journals of Environment and 

Sustainable Development (IJSETR) Paper on Multi handling Pick and Place Robot] The machine involves a 

combination of gripper and vacuum suck mechanism and Motion controlled using revolute joints for lifting, gripping, 

and placing several parts. This is a multi-head type PNP.  

 

III. METHEDOLOGY 
 

Ansys software is used for FE Analysis. This project aims to design and fabricate the pneumatic arm for pick and place 

of cylindrical objects. They conclude that arm is controlled by manually flaw control and direction control valve. Arm 
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rotation and movement is done by pneumatic cylinder using helical slot mechanism. Total arm weight is 25 kg. The 

model is expected to lift at least 10 kg weight, Experimental aim is to collaborate the gripper mechanism and vacuum 

sucker mechanism working in single pick and place automation. Local reinforced elements must be included during 

construction of arm shell. The mast light gear reducer, harmonic drive types are used but because of lack of alignment 

causes disassembly of gear package to avoid these flexible couplings are required. Gabrielle J.M. Tuithaf, Just L. 

Harder. Current automations are not safe for interaction with humans, especially for children therefore safe four DOF 

automation is develop. Energy consumption of given operation as a function of the task execution time. Future work 

includes improvement of the motor model, development of online programming algorithms. Analysis of speed, 

distance, load lifted by arm is done to know its performance. This automation expected to overcome the problem such 

as placing or picking object that is away from the user, pick and place hazardous object fast and easily. It deals with 

different types of Arm design, controlling techniques, vehicle design etc. ER. Rajput, in this book the operation and 

control of automation is discussed. Arduino cookbook, in this book details and methods of interfacing hardware 

components such as Stepper motor and UNO Arduino, is been discussed. 

 

IV. RESULTS AND DISCUSSION 
 

1. A Toolbar with buttons for common functions and a series of menus. The toolbar buttons allow you to verify 

and upload programs, create, open, and save sketches, and open the serial monitor.  

2. The message area, gives feedback while saving and exporting and also displays errors.  

3. The text editor for writing your code. 

4. The text console displays text output by the Arduino Software (IDE), including complete error messages and 

other information. 

The bottom right-hand corner of the window displays the configured board and serial port. 

 

 
FIGURE NO 01: Arduino Software IDE 

 
Now that you are all set up, let’s try to make your board blink! 

5. Connect your Arduino or Genuino board to your computer. 

6. Now, you need to select the right core & board. This is done by navigating to Tools > Board > Arduino AVR 
Boards > Board. Make sure you select the board that you are using. If you cannot find your board, you can add it 

from Tools > Board > Boards Manager. 

http://www.ijmrset.com/
https://docs.arduino.cc/static/ebf961f81c305e826d52e3401863b48e/29114/arduino-ide-interface.png


International Journal Of Multidisciplinary Research in Science, Engineering and Technology (IJMRSET) 

                  | ISSN: 2582-7219 | www.ijmrset.com | Impact Factor: 7.521| Monthly Peer Reviewed & Referred Journal | 

        | Volume 7, Issue 4, April 2024 | 

       | DOI:10.15680/IJMRSET.2024.0704137 |  

 

IJMRSET © 2024                                                              |     An ISO 9001:2008 Certified Journal   |                                        8819 

 

 

 

7. Now, let's make sure that your board is found by the computer, by selecting the port. This is simply done by 

navigating to Tools > Port, where you select your board from the list. 

 

FIGURE NO 02: Selecting the port 
 

8. Let’s try an example: navigate to File > Examples > 01.Basics > Blink. 
 

 

 
FIGURE NO 03: Opening an example 
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9. To upload it to your board, simply click on the arrow in the top left corner. This process takes a few seconds, 

and it is important to not disconnect the board during this process. If the upload is successful, the message "Done 

uploading" will appear in the bottom output area. 

10. Once the upload is complete, you should then see on your board the yellow LED with an L next to it start 

blinking. You can adjust the speed of blinking by changing the delay number in the parenthesis to 100, and upload 

the Blink sketch again. Now the LED should blink much faster. 

 

 
 

FIGURE NO 04: PROGRAMMED BOARD LINK 
 

Congratulations! You have successfully programmed your board to blink its on-board LED! You can find more 

information about the Arduino Software (IDE) 2.x here. 

 
V.CONCLUSION 

 
Robot pick and place automation speeds up the process of picking parts up and placing them in new locations, 

while also increasing production rates. These pick and place robots are more accurate and do not fatigue while doing 

back-breaking or hard to maneuver movements that may be difficult for humans. The consistency, quality and 

repeatability of a pick and place robot system is unmatched. These systems are also versatile and can be reprogrammed 

and tooled to provide multiple applications for consumers. 

 

VI. FUTURE SCOPE 
 

 Our efforts to develop a low-cost integrated system for development of pick and place robot have thus far 

resulted in the iterative development of a tested, proven hardware platform. The software stack has been developed for 

localization, navigation, and radioactive element detection. Future work can be done on the robustness of court 

localization and further code optimizations, which are two necessary steps for the integration of these components. The 

eventual goal for this project is fully automated bottle filling pick and place robot with minimum space. The 

preliminary results for localization, motion planning and bottle detection are encouraging. The communication from the 

Robots to GUI application can be implemented through the base station so that it can control up to 10 Robots from the 

GUI application through the base station that use a secured wireless channel using encryption and decryption. 

Considerably larger bandwidth system should be on board because video streaming service is desired. The future work 

can make the system robust to environmental variations; it can also aim to develop the decision-making functionality of 

the platform to create a truly autonomous system. 
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